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Introduction

This guide provides instructions for operating the Call Center Viewer™ application for 
Microsoft® Windows® 95. The Call Center Viewer runs on an IBM-compatible PC and 
provides Automatic Call Distribution (ACD) group and agent status information.

This guide is written assuming that you are familiar with operating a PC, mouse, and Win
software.

Organization
This guide is divided as follows:

♦ Chapter 1—Grand Tour provides an overview of the Call Center Viewer application. 
explains the various viewing options and how to access information from the Main 
Window.

♦ Chapter 2—Installation provides hardware and software installation instructions.

♦ Chapter 3—Operation explains how to customize Group and Agent information, set 
alarms, sort data, and expand or summarize viewing options. This chapter contains 
the operational instructions for using the software.

♦ Chapter 4—Wall Boards explains how to use the Call Center Viewer to configure the
Spectrum Wall Board. Also included are instructions for sending messages to Wall 
Boards.

How to Use This Guide
We suggest that you read this entire guide and get acquainted with the on-line help scre
described in Chapter 1—The Grand Tour.
Introduction iii
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Conventions

CAUTION! Advises you that hardware, software applications, or data could be damaged
if the instructions are not followed closely.

Note Elaborates specific items or references other information.

Important! Calls attention to important instructions or information.

Courier letters represent keyboard keys or entries from a keyboard. 

Times Roman words that are capitalized represent a specific dialog box button
example: Transfer button.

“Click” means to press and then release the mouse button without moving t
mouse.

➤ denotes the step in a one-step procedure.

~ means “through”. For example: 5~10.

Tab in this document refers to the title of an on-screen card. When yo
click on a tab on screen, that card is brought to the front of the sta
for viewing and editing purposes.

➤ The left column gives 
you the single or 
numbered steps you 
need to perform a 
procedure. These 
steps apply to both 
mouse or keyboard 
use.

The right column gives the immediate response to your 
action. This column also includes additional notes and 
comments.
iv Call Center Viewer
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Related Documents
The following documents can be referenced for additional information:

♦ Strata DK424 Call Center Solutions General Description provides a system overview,
including hardware and feature information. Highlights the technology employed in 
operating the ACD Strata DK424 system.

♦ Strata DK ACD Agent Guide describes the ACD Agent feature operation along with 
step-by-step procedures for using features.

♦ Strata DK ACD Supervisor Guide provides instruction on how to use the ACD 
supervisor features.

♦ Strata DK Installation and Maintenance Manual, Chapter 11—DK424 ACD 
Installation. 

♦ Strata DK Programming Manual , Chapter 6—Automatic Call Distribution.
Introduction v
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Grand Tour 1

This chapter provides an overview of the Call Center Viewer application. It includes basi
requirements, available ACD information, and explains the main menu and viewing optio

Overview
The Call Center Viewer application connects directly to the Strata DK or to other Call Ce
Viewer applications, such as an ACD Management Information System (MIS) or Toshiba
Software MIS (SMIS). When used with a SMIS or MIS, the Call Center Viewer applicatio
provides cost-effective, incremental growth.

The Call Center Viewer organizes and displays events reported by the Strata DK MIS po
provides much of the display information offered by ACD/MIS supervisor monitors, but it
works on a PC. Call Center Viewer enables ACD supervisors to see the following:

♦ Number of Calls in Queue

♦ Number of Agents Available

♦ Number of Agents Busy

♦ Number of Agents Logged-In

♦ Number of Agents Unavailable

♦ Individual Agent States and State Times

♦ Longest Call Waiting

♦ Strata DK Date/Time

♦ Wall Board Messages

The data displays on a host PC and can also be summary information can be sent to an o
Wall Board.
Grand Tour 1
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Main Window
When the Call Center Viewer application starts, the Main window displays as shown bel

Main Menu
Submenus for each item on the Main Menu provide access to file management, various 
configuration windows, and the on-line Help.

Tree View
When the Call Center Viewer application starts, the objects are displayed in Tree View, 
including ACD Groups, Agents, and Reader Boards.

List View
The List View has a variety of features. You can:

♦ View call events updates reported by the Strata DK system

♦ Sort the List Views

♦ Customize names (Groups, Agents, and Reader Boards)

When the Call Center Viewer application launches, both Tree and List Views are blank. 
Depending on the Strata DK system connection type (monitor or direct) the List Views w
begin displaying data as call events occur or when a database download is received. Th
Center Viewer application can only request a database download when it is connected d

Main Menu

Tree View List View

Status Bar
2097
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In the Monitor connection, the Call Center Viewer application depends on the system tha
connected directly to the Strata DK MIS port to request a database download.

Notes

● Depending on the Strata DK system and ACD traffic levels, the call event data can b
into a buffer. When Strata DK system buffers the data, real-time displays of the Call 
Center Viewer application may appear slightly delayed.

● The Call Center Viewer information is immediately updated when it receives call eve
data from the Strata DK system MIS port.

Status Bar
The Status Bar is at the bottom of the application work space. The left side shows conte
sensitive information; the right side displays the date and time from the Strata DK system

The date and time shown on the Status Bar is set from Strata DK system. If the Strata D
system date/time is incorrect, there are no adverse effects to the Call Center Viewer. Yo
set the date/time of the Strata DK from port 000 (normally station 100 or 200), an Attend
Console, or from a TTY terminal. See the Strata DK Administrator or refer to the Strata DK 
Installation and Maintenance Manual for more information.

Wall Boards
The Call Center Viewer application supports Spectrum Wall Boards. The Call Center Vie
application supports a Wall Board network which can display Group data to every active 
group. You can assign one Group to a Wall Board or you can assign several Groups to th
Wall Board. Each Wall Board can be controlled individually with the same information as
another Wall Board, or with different information. This enables each Wall Board to receiv
status information for individual or multiple ACD Groups.

Custom Messages
You can send custom messages from the Call Center Viewer application to individual W
Boards, Groups of Wall Boards, or to all Wall Boards. Custom messaging can be used t
motivational messages (i.e., “Congratulations We Made the Numbers”) or for informing a
ACD group of current priorities (i.e., “Meeting at 2:00”). All other messages, including AC
information, suspend for the duration of a custom message.
Grand Tour 3
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Installation 2

This chapter includes:

♦ Hardware configuration, with multiple host and slave PCs, as well as SMIS/MIS 
connections

♦ Instructions on how to install the Call Center Viewer and optional Wall Boards

♦ Use of Demonstration Mode, a software tutorial for first-time users

♦ Program Removal

This chapter explains how to install the Call Center Viewer application. The instructions 
chapter assume that the Call Center Viewer hardware has been already been configured
instructions in the Strata DK Installation and Maintenance manual, Chapter 11–DK424 AC
Installation. 

Step 1: Before You Start

Make Sure You Have Everything
♦ Software (two 3.5” 1.44 MB disks)

♦ User guide

♦ Installation instructions

♦ Activation key that installs on the parallel printer port

♦ Demo Disk

The PC is customer-supplied and is not included in the kit.
Installation 5
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Make Sure Your PC Meets the CCV’s Requirements
Toshiba recommends installing the Call Center Viewer application on ACD Supervisor’s 
The host PC does not have to be dedicated to this application, since the Call Center Vie
application was designed for multi-tasking. 

When the Call Center Viewer application connects to the Strata DK system, it functions 
machine-to-machine interface, constantly updating call center data. The Call Center Vie
application should be installed on a PC with the following minimum requirements:

♦ Microsoft Windows 95

♦ IBM-compatible PC with 100MHz Pentium processor

♦ 16MB of RAM

♦ Hard drive with 10MB of available space

♦ One available serial communication port; two if Wall Boards are used

♦ VGA color monitor

♦ Mouse

Increasing the PC’s processor speed and adding RAM will improve the host PC’s 
performance; therefore, boosting the performance of the Call Center Viewer application.

Each copy of the Call Center Viewer application functions independently from other 
connections, enabling each Group Supervisor to view real-time data associated with his
particular Group.
6 Call Center Viewer
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Step 2: Install the Software Protection Device

Step 3: Install the Call Center Viewer Program

1. Remove the printer cable, if 
present.

2. Install the green Software 
Protection Device onto the 
parallel port of your PC.

This device also enables Wall Board connections.   See 
“Wall Boards” for installation instructions.

3. Reconnect printer cable, if it 
was removed in step one.

The green software protection device will not interfere
with your printing process.

1. Insert the Call Center Viewer 
Program Disk 1 into your 
floppy disk drive.

2227

2. Select the Windows 95 Start 
button, then select Settings, 
then Control Panel. 

��
��

��
��

Call Center Viewer

2220
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Step 3: Install the Call Center Viewer Program ———————————————————————————————
3. From the Control Panel 
window, select Add/Remove 
Programs.

2224

4. From the Add/Remove 
Program Properties dialog 
box, click Install.

5. Click Next and follow the 
prompts to finish installing 
the program.

2200
8 Call Center Viewer



—————————————————————————————————————— Step 4: Set MIS Configuration
Step 4: Set MIS Configuration
1. Launch the Call Center 

Viewer program by clicking 
the Start button, Programs, 
then Call Center Viewer

...or click the Configure 
menu, then the MIS submenu.

Note When you first install the program with the 
program disks, the MIS Configuration dialog 
box automatically appears when the program 
is launched. (Afterward, use the Configure 
menu to access it.)

2. From the Interface tab, select 
the MIS port.

2113

The MIS port is the host PC serial communications 
port assignment for connection to the Strata DK 
System.
Installation 9
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3. Select the baud rate between 
the Wall Board(s) and the 
host PC.

Use the highest available 
speed that is supported by the 
Strata DK system and Wall 
Board(s).

COM port speed is affected 
by the number and types of 
peripheral devices (i.e., 
modems, TTY, SMDI) 
running on the Strata DK 
I/O port.

Make sure this setting matches the baud rate of the 
Strata DK system MIS port.

CAUTION! If the baud rate (channel speed) is not 
set high enough, the Strata DK system 
MIS buffer may overflow, causing loss 
of data to the Call Center Viewer 
application. See the Strata DK 
Installation and Maintenance Manual 
for more information.

4. Set the MIS Parity. When you use the Strata DK system, the MIS Parity
permanently set to Even.

5. Set the MIS Word Length. When you use the Strata DK system, the Word Len
is permanently set to seven.

6. Select the Date/Time tab.

7. Select the Style for the Date 
displayed within the 
application, either alpha 
numeric (June 10, 1997) or 
numeric (6/10/97).

8. Select the Format (check for 
24-hour format; no check for 
12-hour format) and Style for 
Time (with or without 
seconds).

2111
10 Call Center Viewer
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9. Select the MIS tab.

10. If you are configuring the 
master PC, check the Request 
Database Download box. 

Do not check this box if you 
are configuring slave PCs.

If MIS or SMIS is connected, 
do not check this box.

2100

Important! Only the master PC can communicate with 
the Strata DK system.

11. Always check the Use Check 
Sum box if the Call Center 
Viewer application connects 
to the Strata DK system.

12. Use the arrows to select the 
Channel Time Out. 

Toshiba recommends setting 
no less than 60 secs. 

Channel Time Out is the maximum time for idle 
connection before the alarm turns on. The application
monitors the communication line between the Strata 
DK system and the host PC. When the connection is
dropped, an alarm message displays on the host PC.

Note There are no warning messages when the MIS
dialog box is open.

13. Select a Default Group to 
display in the Title Bar 
Display.

For information on Title Bar Display, see Page 24.

Note You cannot select a group if data is not being 
collected (no activity).

14. Select the number of minutes 
to display Logged Out 
Agents.

15. Click OK. The MIS Configuration window closes and the full 
Call Center Viewer screen is visible.
Installation 11



Using Demonstration Mode (Optional) ——————————————————————————————————

de to 
ges to 
 

Using Demonstration Mode (Optional) 
After you install the software from the program disks, you can use the Demonstration Mo
familiarize yourself with the Call Center Viewer features, such as sending custom messa
a Spectrum Wall Board. Any changes made while operating in Demonstration Mode are
discarded when the application is shut down.

➤ To run the Call Center Viewer in the Demonstration Mode 

1. Remove the Software 
Protection Device connected 
to the host PC’s printer port.

Important! Removing the Software Protection 
Device clears all entered information 
and the settings will revert to default 
data. For this reason, Toshiba highly 
recommends that if you want to run 
Demo mode, that you do so before  
setting up the application in a work 
environment. 

2. Make sure the software has 
been installed and the MIS 
configuration has been set per 
the following:

“Step 3: Install the Call 
Center Viewer Program” on 
Page 7 and “Step 4: Set MIS 
Configuration” on Page 9.

3. Launch the Call Center 
Viewer program by clicking 
the Start button. From the 
menus, select Programs, then 
Call Center Viewer.

4. Click Yes.

2110

5. When you are done, select 
File, then Exit.

 

12 Call Center Viewer
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Program Removal
When you are not using the Call Center Viewer, you can minimize it or exit from the File
menu. However, if you need to remove the Call Center Viewer application from the host 
use the following instructions.

➤ To uninstall the Call Center Viewer

6. Reminder: Reattach the 
software protection device(s) 
before you launch the 
program. (See “Step 2: Install 
the Software Protection 
Device”.)

1. Shut down the program.

2. Click the Windows 95 Start button. From 
the menus, select Settings, Control Panel, 
and Add-Remove Programs.
Installation 13
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3. From the list of installed software 
programs, select Call Center Viewer, then 
click Add/Remove.

4. Click the Yes to Confirm File Deletion.

5. From the Uninstall Shield dialog box, 
click OK.

6. Remove the green software protection 
device key.

2130
14 Call Center Viewer
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Operation 3

This chapter covers the following topics:

♦ Groups

♦ ACD Groups

♦ Alarm Configuration

♦ Agents

♦ Sorting in List View

♦ View Menu

♦ File Menu

Once the MIS system is configured, organizing the ACD Groups and Agents is your nex
logical task. This chapter includes instructions on customizing Groups’ and Agents’ nam
sorting information, setting alarm sounds and triggers, selecting screen colors, and print
displays.

Important! With a slave/host configuration, it is preferable to boot up the slave compute
before the host computer, so that Agent information is immediately available 
when the host is turned on. If the slave PC is turned on after the host PC, Ag
will be recognized after a change in state for each individual Agent.
Operation 15
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List and  Tree Views
The List View shows the names and statuses of all ACD Groups with reported activity (s
the time that the Call Center Viewer application was launched). Or, you can open a Grou
Object in Tree View and select an individual group to see the List View of a single ACD 
Group.

An example of a Group List View is shown below:

Hide or Open Objects in Tree View

➤ Double click on the object

...or select the minus/plus symbols ( -/+ ) of the object icon (folder)

...or select the object and press the minus/plus keys ( -/+) on the keyboard.

Moving from object to object

Click on an object, then use the up/down arrow keys, or page up/down keys.

Moving from Object to Object

➤ Click on an object, then use the up/down arrow keys, or page up/down keys.

2098
16 Call Center Viewer
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ACD Groups
There are two parts to creating an ACD Group. First, a name should be assigned. Secon
Alarm thresholds should be set for each group.

The Strata DK system organizes ACD Groups by number and does not support Group n
Default group names are “Group,” plus the number reported by the Strata DK system (i.
Group01). With the Call Center Viewer application, you can change group names to some
more definitive, such as “Customer Service.” You can also sort the Name column.

The Group Number reported by the Strata DK system displays in the Call Center Viewer
reference purposes only. The group number cannot be changed in the Call Center Viewe
application.

Step 1: Assign or Change an ACD Group Name

1. From the Main Menu, select Configure, 
Groups, then select a group

...or from the Tree view, click on the 
Groups icon, then double-click on the 
group in the List View.

2423

2. Enter an ACD Group name. Click OK.

2104
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Organizing Names for Sorting

You can add a prefix to names such as A, B, C, East, or West to organize and sort them
Groups. You can arrange them by work shifts or regional responsibilities.

If a particular Group or Agent needs special attention during training or work reviews, as
the prefix “1” to the name. This places that name at the top of the list during an ascendin
For instructions on sorting, see “Sorting in List View” on Page 23.

Step 2: Set the ACD Group Alarm
The alarm tab enables you to set alarm threshold information for each ACD Group. The 
values set here will apply to the ACD Group on the corresponding ACD Group tab.

The alarm activates when an alarm value exceeds the Group’s current alarm threshold. Y
change the alarm’s color, make the screens flash, etc., from this tab. For audible alarm se
see “Alarm Configuration” on Page 20.

There are three alarm categories for ACD each group:

♦ Calls-In-Queue

♦ Longest-Call-Waiting

♦ Unavailable-Agents

There are two different dialog boxes which affect alarm settings. Alarm thresholds for AC
Groups is set from the tab accessed from the ACD Groups dialog box; alarm configurati
accessed from the Configure menu.

➤ To set an Alarm for an ACD Group

1. From the Main Menu, select 
Configure, Groups. Select a 
Group

...or from the List View, select 
an ACD Group, then double-
click on the Group’s Name.

2423
18 Call Center Viewer
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2. From the ACD Groups dialog 
box, select the Alarm tab.

3. From the Alarm dialog box, 
set the desired values.

2101

Each Alarm displays its threshold. To activate an 
Alarm, a value must exceed the group’s Alarm value 
setting.

4. (Optional) click Color. From 
the Color dialog box, select a 
new color, then click OK.

5. From the Alarm dialog box, 
click OK.
Operation 19
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Alarm Configuration
You can set the alarm characteristics and assign the alarm to all Groups or only to the default 
Group from the Alarm Configuration dialog box.

To configure the Alarm

1. From the Main Menu, select 
Configure, then Alarm.

2424

2. Select Wave and a .WAV  (sound) file
or...select Speaker.

3. Check the options that you want.

4. Click OK.

2206
20 Call Center Viewer
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Agents
The List View shows individual Agents and constantly updates to display each Agent’s cu
ACD State (see below). The State timer begins when an Agent call event change is recei
the Call Center Viewer application. The State timer increments in one second intervals u
the next Agent call event.

Agent States

Agent States are determined by call events received from the Strata DK system (see be

1Gate Call stands for ACD calls, which come into the system through the ACD gateway.

Note Logged Out Agents displays for the duration of the “Display Logged-Out-Agts for
control, which is located on the MIS tab of the Configure menu.

Agent States

Strata DK
Call Event

Logged In Logged-Out Available Unavailable Busy

Log In Yes No No No No

Log Out No Yes No No No

Available Yes No Yes No No

Unavailable Yes No No Yes No

On PBX Call Yes No No No Yes

On Gate1 Call Yes No No No Yes

In After Work Time Yes No No No Yes

List View

2097
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Agent Names
Agent names that are initially programmed into the Strata DK system download to the C
Center Viewer application’s database. The Strata DK system name field allows up to eig
characters, whereas the Call Center Viewer accepts up to 24 characters. With the Call C
Viewer, you have the room to enter an Agent’s full name (i.e., Joseph Paul Baldwin).

Note Under some conditions, Agents’ names are not received from the Strata DK syst
(see “Step 4: Set MIS Configuration” on Page 9). If the names do not automatically 
transfer to the database, the Call Center Viewer application displays “AgentXXXX
“XXXX” appears in place of the Agent ID number, assigned in the Strata DK syst
programming.

You can enter Agent names from the Call Center Viewer application, instead of the Strat
system.

To change Agent’s names, you must select the Agent from the List View. This feature is 
available from the Main Menu level.

➤ To assign or change an Agent’s name

1. From the Tree View, double-
click on the Groups icon to 
list all Groups.

2. Double-click on the desired 
Group.

3. Click on the Agents folder.

4. In the List View, double-click 
on the Agent’s name to access 
that tab.

5. From the Agent dialog box, 
enter a new name.

6. Click OK.

2211

The Call Center Viewer application now only uses this
name for the associated Agent ID.
22 Call Center Viewer
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Notes

● See “Organizing Names for Sorting” on Page 18.

● Agent IDs (Agent’s log in codes) are entered/changed through programming in the S
DK system. The agent dialog box contains the Agent ID for reference.

Management Tips for Agent names

If you plan to use the Call Center Viewer application to change Agent names, program ge
Agent log-in codes and names in the Strata DK. Example, you can use the ACD Group n
plus a two-digit Agent number (0105 = ACD Group 1, the fifth Agent). Strata DK Agent 
names are “AGT” + “Log-In-Code” or AGT0105.

This convention eliminates the need to reprogram the Strata DK every time an Agent is 
or leaves the company. All Agent names can then be customized from the Supervisor’s 
with the Call Center Viewer application.

Sorting in List View
ACD Group and Agent data can be sorted in ascending or descending order (numerical
alphabetically, whichever applies) from the List View.

➤ To sort Agent or Group data in list view

➤ Click on any column heading 
in the List View.

2223

The sorting process alternates with each click. For 
instance, if the names sorted in ascending order, the 
next click sorts in descending order.

Column Headings
Operation 23
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Notes

● The descending sort of the Groups’ Name column can be used to place Groups with
most calls in queue or the longest hold times at the top of the screen. (Groups with z
appears at the bottom of the screen, i.e., Groups with no activity or calls in queue).

● A descending sort of the State column lists Unavailable Agents at the top. This helps
to identify which Agents you can put back into service to handle a sudden increase i
queued calls.

View Menu
The View menu enables you to switch from the Main Menu display to the Title Bar displa
You can also set the Title Bar to display Always on Top.

Title Bar Display
You can display the Call Center Viewer in the form of a Title Bar to minimize the applicati
foot print on the desktop (shown on the following page). The Title Bar View is a compact
display which enables you to monitor the default ACD Group while working in other 
applications on the PC. (The default ACD Group is set from the MIS Configuration tab.)

➤ To display the Title Bar

➤ From the Main Screen, double-click the center of the Call 
Center Viewer application title bar

...or from the View menu, select Title Bar Display.
2112
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MIS 
The Title Bar labels, such as CW, are predefined and cannot be changed.

Notes

● The ACD Group shown is set in the Default Group setting. Select MIS configuration, 
tab, to change the Group.

● The Title Bar Display may also be placed at the bottom of the open application.

2121

Label Definition

CW Calls Waiting is the number of calls in a Group’s queue. CW updates when calls enter or 
leave the queue.

Note The alarm activates when a value equals or exceeds the Group’s alarm setting.

LCW Longest Call Waiting  displays the waiting time for the oldest call in an ACD queue. LCW 
updates when calls leave the associated ACD queue. See above Note.

LOG Logged In Agents displays the total number of active Agents logged in to an ACD Group 
since the start of the Call Center Viewer session.

Avail Available Agents constantly updates to show the total number of idle and available 
Agents.

Unavail Unavailable Agents displays the total number of unavailable Agents. Agents are 
Unavailable when they press Unavailable on their ACD telephone. This column updates 
when individual Agents’ Available/Unavailable status changes.

Busy continually updates to show the total number of Agents who are considered Busy, with 
any of the following activities:

♦ On an ACD call

♦ On a PBX call

♦ In After Call Work Time (wrap-up time)

♦ Entering a Work Unit
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Always On Top
This menu item places the Call Center Viewer application as the top-most window on th
desktop. If you open other windows, the Call Center Viewer window will be in front of the
other windows.

You can use the Title Bar View with Always On Top. When both of these options are sele
you can move the Title Bar anywhere on your screen. This enables you to view the Title
while working in another application. The screen print below shows the Title Bar being 
displayed at the same time as a Microsoft Word file.

➤ To activate/deactivate Always On Top

➤ From the View menu, select Always On Top 
(toggles).

2431

Note Always on Top does not mean the Title Bar will be at the top of your screen; it 
means that the Title Bar will be on the top layer (in front of) whatever 
application you are working on. (Example shown below.)
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Button View
The button view is a convenient way to view ACD group status while working in other PC
software applications. When you highlight the Call Center Viewer button View, a summa
version of the ACD Title Bar pops up just above the Windows taskbar (see following figu
Button view shows the number of calls in queue and the longest call waiting.

➤ To access the ACD information in Button View

1. From the View menu, turn Always On Top OFF.

2. From the View menu, select Title Bar Display.

3. Open or select another application to place the Title Bar in the background.

4. Use the mouse to point to the Call Center Viewer application button on the Windows
taskbar, at the bottom of your screen. (You may need to move the mouse pointer aro
the button).

Help Menu
The Call Center Viewer comes with on-line help. The Help section has an Index tab whic
contains Topics. It also has a Find tab, which contains the Find Setup Wizard for quick t
searches.

➤ To access on-line Help

➤ From the Main Menu, select Help, Help Topics.

...or press the F1 key while in the Call Center Viewer application.

2426
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File Menu

Print Font
The Print Font dialog screen enables you to select a font from the various, styles, sizes, e
and colors available in the host PC. The font selected here is used for the Agent List pri

➤ To select a print font

Print
You can print lists based on the currently displayed List Views of Groups or Agents. Use
Agent ID (i.e., 0101) as a cross-reference when comparing the Agent List print out to ac
Strata DK system programming. An example follows.

1. From the Main Menu, select File.

2. From the File menu, select Print 
Font.

2214

3. Select the Font, style, size, etc.

4. Click OK.
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➤ To Print ACD Call Center Viewer Statistics

1. From the Main Menu, select File, then Print.

2. Click OK.

Print Preview
Enables you to preview the font style and size of the printout for all defined Groups and 
associated Agents with this menu item.

Print Setup
Enables you to call up the host PC’s printer properties sheet with this menu item. The P
Setup enables you to configure printers within the Windows environment.

Exit  

Enables you to exit (shut down) the Call Center Viewer application. Shutting down the C
Center Viewer application ends your communication with the Strata DK system.

➤ To Exit the Call Center Viewer, from the Main Menu, select File, then Exit.
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Wall Boards 4

This chapter assumes that the physical Wall Board has been installed per instructions in
Strata DK Installation and Maintenance Manual, Chapter 11–DK424 ACD Installation.

Important! The term “Wall Board” refers specifically to the physical Wall Board. Only 
Spectrum brand Wall Boards can be used. In the Call Center Viewer applica
“Reader Board” is used in place of “Wall Board.” 

Once the board(s) are mounted, you can use the ACD Call Center Viewer to change sett
send messages to the boards. If you are installing a Wall Board, you need to configure i

From the Reader Boards submenu, you can:

♦ Configure a New Wall Board

♦ Adjust the communications settings between the host PC and the Wall Boards

♦ Delete an existing Wall Board
Wall Boards 31
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New Wall Boards

Step 1: Set the Wall Board Configuration  
If you are adding Wall Boards, you must configure a second PC communication port. The first 
port was set up to enable the Call Center Viewer to communicate with the MIS connecte
the Strata DK System. That was performed in Installation, “Step 4: Set MIS Configuration”. 
Now, you must configure the second port to enable communication between the host PC
the Wall Boards.

The Settings option enables you to match the physical settings for the communication int
between the Wall Boards and the host PC.

➤ To configure the Wall Board 

1. From the Configure menu, 
select Reader Boards.

2. From Reader Boards 
submenu, select Settings.

2117

3. From the Wallboard 
Configuration dialog box, 
select the Wall Board (WB)  
communication port on the 
host PC that is connected to 
the Wall Board(s).

4. Select the baud rate between 
the Wall Board(s) and the 
host PC.

Use the highest available 
speed that is supported by the 
Strata DK system and Wall 
Board(s).

2129

Note Make sure that the settings match those of the
host PC.
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Step 2: Configure the Wall Board
When you add a Wall Board to the application, you need to enter general information, su
its address (location), type, and display speed. You also need to assign Groups to the W
Board. And you can choose Agent and Call Labels in the process.

➤ To assign a new Reader Board to a Group

5. Set the WB Parity to Even.

6. Set the WB Word Length to 7 
bits.

7. Click OK when done.

1. From the Configure menu, 
select Reader Boards.

2. From Reader Boards 
submenu, select New.

2117

3. From the Reader Board 
dialog box, select the General 
tab. 

4. From the General Tab, enter a 
new Wall Board Name or use 
the default. (Default includes 
the ID number. i.e., 
ReaderBoard2.)

2106
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5. In the ID box, enter the 
Identification (logical 
address).

All Wall Boards with the 
same ID will receive the same 
messages.

All data sent to the Wall Boards contains the address
in a header.

Note The Call Center Viewer allows up to 16 
addresses; however, the Spectrum Wall 
Boards can have duplicate addresses. This 
increases the number of Wall Boards that can
be installed.

6. In the Type box, enter the 
Wall Board model, such as 
Spectrum model 215R Red 
LED.

7. In the Speed box, enter the 
message display speed.

8. In the Location box, enter the 
Wall Board’s physical 
location, such as West Wall or 
East Wall.

9. Check the Date & Time box 
to activate this display.

10. Select the Agent Labels tab.

♦ Choose Abbreviated or 
Formal Labels

♦ Select specific labels 
from the drop-down 
boxes.

2107
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11. Select the Call Labels tab. 

♦ Choose Abbreviated or 
Formal Labels.

♦ Select specific labels 
from the drop-down 
boxes.

2209

12. Select the ACD Groups tab.

13. Select the Groups to be 
displayed on the Wall Board. 
Move them from the 
Available list to the Member 
list by:

Double clicking on a Group

...or selecting a Group and 
clicking the arrow keys.

14. In the Duration box, select the 
amount of time in-between 
each group’s message. 

15. In the Delimiter box, indicate 
any characters that will be 
used to mark the end of one 
message and the beginning of 
another.

2108

Note More than one group can be assigned as a 
Member to one Wall Board. All of the 
Available Groups can be display Members.

16. When you are done with all of 
the tabs, click OK.
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Removing Groups from the Message List

Changing the Reader Board Settings

1. From the Configure menu, select Reader Boards.

2. From Reader Boards submenu, select New.

3. Select the ACD Groups tab. 

4. Double-click on a Group or use the arrow keys to move them back to the Available L

5. Click OK.

1. From the Configure menu, select 
Reader Boards.

2. From Reader Boards submenu, 
select the name of the Reader Board 
to be changed (i.e., Tech Support1).

2225

3. From the Reader Board dialog box, 
select the appropriate tab, and make 
changes. 

2106

4. Click OK when you have completed 
all changes.
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Deleting Reader Boards

Messages  

You can send custom messages from the Call Center Viewer application to an individua
Group’s Wall Board or to all Wall Boards. When a custom message displays, all ACD 
information displaying on the Wall Board suspends for the custom message’s duration.

All custom messages are sent from the host PC that is connected to the Wall Board. If c
messaging will be used frequently, or by more than one Supervisor, Toshiba recommend
configuring each Supervisor’s PC as a host terminal.

➤ To write and send a message

1. From the Main Screen, double-click the Reader Boards icon in the Tree View to disp
the List View.

2. Select the Reader Board to be deleted from the List View. 

3. From the Configure menu, select Reader Boards, then select Delete from the subm

4. Click Yes to delete the Reader Board.

1. From the Configure menu, 
select Messages.

2213
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2. From the Messages tab, select 
New to write a message.

2208

3. From the Message dialog 
box, enter in the ID box, a 
short title to identify the 
message, such as “Good 
Job!” for “We met the budget! 
Good Job!”

2099

4. Enter the amount of message 
display time, in seconds. 

All ACD information on the Wall Board suspends 
during the custom message.

5. Enter the message to be 
displayed.

6. Click OK.
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7. From the User Defined 
Messages dialog box, select 
the Wall Board(s) to display 
the message.

8. Select the message to be sent.

2114

9. To send the message to the 
selected Reader Board(s), or 
all Reader Boards with the 
same Identifier address, click 
Send

...or to display create new 
messages, click New

...or to eliminate the selected 
message Identifier and the 
associated message, click 
Delete

...or to change messages, 
click Edit or double-click on 
the message.

10. Click OK. The message is sent to the appropriate Wall Boards.
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